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1 SYSTEM COMPONENTS 

1. Central unit

2. LCD Graphic Display

3. Pressure transducer

4. Length/angle sensor

5. Anti-Two-Block switch
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2 SYSTEM OPERATION 

2.1 CONTENT OF DISPLAY 

1. indication light of A2B switch

2. pre-warning light

3. overload warning light
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a) bargraph (load moment percentage indication) 

b) OM display  

c) Reeving display 

d) Actual load display 

e) Rated capacity display 

f) Function key 

g) Upper limit angle setting 

h) Lower limit angle setting 

i) Alarm stop 

j) Net weight 
2.2 OPERATION DESCRIPTION 

2.2.1 Setting the operating mode 

The OM setting is used for to adjust the LMI parameter according to the actual crane’s condition. When 
operate the crane please make sure the displayed operation mode is the same with the actual operation 
mode. 

Before operate the crane please check the corresponding OM code according to your crane type and 
actual mode and then adjust the OM to be the same with the actual OM. 

 

WARNING 

The correct setting is of utmost importance for the proper function of the system and the crane. 

Therefore only operators who are thoroughly familiar with use and operation of the system shall 

set this function. 

 

 

Way for correctly setting the operating mode: 

When it is need to adjust the operating mode please press the button  under the Function interface 

(see pic.1), and press the button  to change the language between English and Chinese  

You should do as the following procedures: 
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( pic.1) 

Pressing the key of number “1” enter into pic.2 “ Set operation mode”. (see pic.2) 

( pic.2 ) 

By pressing the number key the actual OM can be input. Let’s take a example: if you want to enter OM 

02, you can press the key “0” to input the number key of “0”and press the function key to next 

digital. And press the number key of “2” for input 2, then press the function key  to confirm this 

time’s operation. If needn’t OM setting operation, please press the function key for return to the 
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upgrade interface. 

2.2.2 Setting the reevings 

This function is for to setting the number of the rope for LMI system. Before operate the crane the 
operator is asked to adjust the displayed reeving to be same with the actual one. 

The relationship between the actual reeving and displayed one is as following: 

Displayed value:                1 ----------16 

Number of parts in line of the ropes: 1 ----------16 

Way for correctly setting the reevings: 

Press the number “2” button under the function interface and enter into “Set reev” (see pic.3) 

 

 

(pic.3) 

The operation for enter the actual reeving is the same with OM setting. 

2.2.3 Setting time 

Only manufacture has this right. 
2.3 ALARM STOP 

The HC3936 system’s warning buzzer will sound alarm under the following conditions: 

— reach max. of rated capacity 

— the hook reach to height limit 

— exceed the permitted movement radius of the crane 

— load moment indicator malfunction 
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— Error operation 
 

Press the key  in the main interface and the audible alarm will be silenced till above condition 

happen again. 

2.4 DESCRIPTION OF INDICATION LIGHT 

2.4.1 A2B indication light 

The red warning light will light up  

as soon as the anti-two-block limit  

Switch contact open, indicating that a two-blocking condition is approaching. At the same time the 

audible alarm will sound. 

The following crane movements will be stopped subsequently: hoist up, telescope out, boom down. 

In order to avoid any injury to people or crane, please check the A2B system before operating the 

crane in the following procedure: 

a. Manually lifting the weight attached to the anti two-block switches, then the audible alarm sound 

and the anti two-block alarm light will light. 

b. Slowly raise the hook or lower the boom or extend(telescope) the boom to create a potential 

two-block condition, when the hook lifts the weight, the audible alarm sound, the anti two-block alarm 

light will light and the crane movement such as hoist up, luffing down, telescopic out will be stopped. 

c. If the light and audible alarm do not function as described and the crane movements are not 

stopped, the system is not working properly. The malfunction shall be corrected before operating the 

crane. 

2.4.2 Pre-warning light 

The yellow load moment pre-warning 

Light will light up when the load on the  

crane reaches the defined pre-warning area 90%～100% of the rated capacity, thus indicating that an 
overload condition is approaching. 

This means for the operator to continue his crane operation with extreme caution. 

2.4.3 Overload alarm light 

The red warning light will light up 

when the load on the crane reaches  

the defined overload capacity of 100%(or 102%,according to country standard) rated capacity, 

STOP
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2.5 SETTING OF UPPER AND LOWER LIMIT 
The LMI system function for the limitation of the boom angle to warn the operator of extreme 

caution under dangerous condition: buildings, bridges, high-voltage wire. 

WARNING 

This limit function is only of warning use but without control function. For each time reset 
the LMI system you need to reset the limit value. 

 

2.5.1 Setting of upper limit angle  

Luff up the boom to max. safe position and then press the key  to set present boom angle as 

upper limit. When this limit value is exceeded the 
STOP

 indication light will  

light up and audible alarm sound to warn the operator to take extremely operate. 

2.5.2 Setting of lower limit angle 

Luff down the boom to min. safe position and then press the key  to set present boom angle as 

lower limit. When the angle is lower than this limit value the
STOP

indication light will light up and audible 

alarm sound to warn the operator to take extremely operate. 

2.5.3 Delete of angle limit 

Simultaneously press the number key“0”then the set limits are deleted. 

Select language interface 

When it is need to select language, please press the button  under the Function interface(see 

pic.1), you should press the button   
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3 HC3936 SYSTEM FUNCTIONS 

1. Warning 
— overload 

— 2 block condition 

— malfunction 

 

Any above condition happens the HC3936 system will light up and sound alarm for warning. 

2. Prohibited 
Cooperating with crane electrics system the system will send alarm warning and any of the 

following crane’s movements will be prohibited: 

— boom luffing down 

— telescopic out 

— hoist up 

 

At this moment only the movements toward safety direction is allowed: 

— boom luffing up 

— boom retract 

— hoist down 
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The LMI system has this cut-off function however the operation toward dangerous direction is not 

allowed when overload or 2 block condition happens. Because this cut-off device is a interacted system, 

in case of any error it may cause big danger.  
 

NOTICE 

When the cut-off device is activated this cut-off signal will always keep be out. Functions such 
as “dangerous direction operation is not allowed”, “only safe direction operation is allowed” is 
realized by cooperating with the crane’s electronics system which including “ safe direction inspect 
switch”, “ safe overflow solenoid valve” etc. The LMI system cannot judge the operation is safe or 
dangerous itself. 

4 SERVICE AND MAINTENANCE 

4.1 CONTENT OF MAINTENANCE 
a. Check all cable connections of the system. Damaged cables are to be replaced immediately. 

b. Check the isolation of the length sensor and A2B switch cable and the cable guides. Worm 
isolations and damaged cable guides have to be replaced. 

c. Inspection of the anti-two block switch as to easy running  

d. Check of the cable reel as to sufficient tight. 

e. Check of the pressure transducers at the hoist cylinders and the connection hoses as to oil 
leakage. 

4.2 LENGTH SENSOR ADJUSTMENT 
When the displayed boom length is not correct (exceed the permitted error range) , please adjust it: 

Retract the boom to the basic boom condition and check the pre-stressing force of the cable 
reel( cable must be tight)and then open the cover of the length/angle sensor and turn the axle of the 
length potentiometer slowly( see arrow mark) till the displayed value to be the same with the actual 
length. 

 

 

Length sensor adjustment (see above arrow) 

4.3 ADJUSTMENT FOR ANGLE SENSOR 
The angle sensor is installed in the same house with the length sensor. 

First, retract the boom to the basic length condition and make sure the displayed value accord with 
the actual length. Use the angle instrument to measure when the actual angle is between 10°and 
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70°whether the displayed vale is the same or use the tape to measure the working radius. If the 
displayed value or radius is not the same with the actual value, you should adjust the angle sensor. 
Please lose the three bolts (see the following pic.). Slowly turn the angle sensor till the displayed value 
accord with the actual value. And then tight the bolts again.   

 
 

4.4 THE REASON FOR BUZZER KEEPING SOUND ALARM 
After start the system it displays without any malfunction or error code but the buzzer keep sound 

alarm, in this case please check if any disconnection or water falls in the connection between length 
cable and A2B switch. 

4.5 CABLE RETRACT NOT SMOOTHLY 
Sometimes when retract the boom it happens that the length cable cannot return to the original 

position naturally or retract not smoothly. It is because of the coil-spring’s pre-tight is too low or the length 
cable in the cable reel fall off. 

Please pre-tighten the length cable several circles to solve the problem: 

1. Retract the boom and put it on the rack 

2. Draw back the tip of the cable from the tip of the boom and retract to the cable reel 

3. Pre-tight the cable reel 3 to 5 circles, to make the cable can be pulled out and retracted smoothly. 

4. Pull out the cable and fix it on the tip of the boom again 

5. After pre-tight the cable reel the display of the boom length will be affected, so at this moment 
please adjust the length sensor till the displayed value the same with the actual length. 
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5 TROUBLE SHOOTING 

5.1 LENGTH SENSOR 
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5.2 ANGLE SENSOR 
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5.3 PRESSURE TRANSDUCER 
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5.4 A2B 
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5.5 NO CONSOLE DISPLAY 

 

 

6 DS380 TOOL 

DS380 Tool is used for uploading, downloading and verifying of system software, Interpol 
data, crawler crane calibration data between PC and HC3900 central unit, it is also possible 
to download overload record from HC3900 central unit. 

6.1 SOFTWARE INSTALLATION  

Double click Setup. Bat in the Setup folder, perform registration of some .OCX file which the 
software need, you can run DS380 TOOL Vx.xx.EXE.  
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6.2 SOFTWARE INTRODUCTION  

6.2.1 Welcome window  

When starts the program, welcome form show as follow: 

 

In the window above we should select which kind of data we will operate. 

System program: This selection is only available on two layer PCB board of old hard ware 
version, in HC3900 it is not possible because system program is not flash but EEPROM. 

Interpol data : data file generated by Interpol software ，extension name is ：da4 

DACdata：Calibration data of crawler crane before July 18, 2007 system software 
DS380_track_xcmg_v3_build071108.hex, default address: 0x40000-0x5dfff, it is now not 
available for HC3900.  

Black box record: for overload record downloading. 

After selecting the data type, press OK button you can go to the main window. 
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6.2.2 Main window    

 

A: Menu：menu of data transmission, software setting, include File, Edit, Communication, 

Setup, Help。 

B: Auto verify check box：when it is checked，the program will check if the data uploaded 
into the central unit is correct automatically after uploading，otherwise the program will 
stop without verifying；when you download data from central unit without auto verify 
checked , a save as dialog box will show ,and you can save the data as binary format. 

C: Progress display：while uploading or downloading of data，you can see how many 
sectors are finished ,and the percentage of finished sector. 

D: File status bar：Indicate the hex file name opened by the program. 

E: Address status bar：Address range of HEX file. 

F: Communication status bar：indicate serial port configuration，when communication is 
running, the light on the right side of bar turns green . 

Menu introduction  
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6.2.3 File -> Load hex file [F2] 

Load hex file which you want to transmit to central unit，or you can also press a shortcut key 
to do this ，if you select system program in welcome form ,you can load file with 
extension name of “*.hex”, if you select  “Interpol data” in welcome form ,you can load 
file with extension name of “*.da4”or “*.dac”.  

6.2.4 File ->Save as binary file 

Convert hex file into binary format file. 

6.2.5 File ->Exit 

Exit program . 

6.2.6 Edit -> Buffer 

Display loaded hex file content or target buffer which you download from central unit as hex 
format or ASC format, in order to switch between file and target buffer content, you  should 
select between option box of “File” and “Chip”. 

 

You can press “Page up” or“Page down” button to skip the buffer address，there are 256 

bytes in one page. 

If  ASCII Mode option is selected ，buffer is displayed as ASC format, for example, in hex 

mode you can read “30 31” in text box , in ASC mode you can read “01”. 
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The text box below “Address” you can input address which you want to read, it is a easy 

way to browse buffer content in different addresses.  

6.2.7 Communication -> Connect [F5] 

Connect to the central unit, please note the operating sequence: 

1. plug the communication cable between central unit and PC serial port , 

2. switch on the power supply of the central unit ,  

3. Click the menu or press F5 on the computer. 

In this step we transmit the operating code into the central unit so that we can do uploading 
or downloading. if everything works well ,you can see the dialog box with message 
“Success!”, it means that the operating code we have sent to central unit is running , or you 

can see the message “Timer out” if the connecting is failure , in this case ,you should check 
if the operating sequence is right ,and if the cable is wiring in right  way ,some time you 
can see the message “No such com port or occupied com port!” after connecting. You 

should check if the setting of serial port number of PC is available or is being opened by 
other software. 

After succeed on connecting, you should keep the power on of the central unit during 
operating, if you turn off the power, you must reconnect as the instruction above. 

6.2.8 2．6 Communication ->Upload [F6] 

transmit the hex file to the central unit , if the connection above has not succeeded , this 
menu is disabled ,if the auto verify check box is checked ,after finish uploading the program 
will read the content of central unit and check if it is right，you should pay attention to this 

operating because it will overwrite the flash memory of central unit ,the program will show 
you the message “All current data on the chip will be lost!” 

 

Select “Yes” to continue uploading and old data in flash is erased, or you can select “No” to 
cancel the operating.  

SkyAzúl, Equipment Solutions www.skyazul.com 
19

301-371-6126



 

Next step, in the input box you can select the sector range you want to write, there are 256 
bytes in one sector, and the default string in the input box is based on the hex file we have 
just loaded. Normally you should not change the range. After input the range ,the uploading 
start, in the top right side you can see the progress of operating.  

 

                                                Current sector number  

                                                Total sector number 

                                                Percentage of process 

     

When the percentage reaches 100% ,the uploading is finished and the program will start 
the verifying if auto verify check box is checked. At first the data we have uploaded in the 

central unit will send back to PC ,then make the comparison with the hex file in the PC ,a 
message window will show the result of comparison , if it is not correct you will see the 
message as following : 

 

The comparison result is saved as ASC format file , you can open the file with notepad or 

any text editor, there three columns in the file ,address, data in flash memory, data in hex 

file, this file can help us find out the reason of the failed transmitting. 
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6.2.9 Setup -> Chip Select 

By the menu we can go back to the welcome window, and change the flash memory we 
want to operate on .after make the changing ,reconnect to the central unit must be done. 

6.2.10 Setup -> Com port  

Setting the serial port number, com1 to com 16 are available. 

 

6.2.11 Setup -> Baud rate 

Setting the baudrate of serial port , 4800 bps,9600 bps,19200 bps,38400 bps,57600bps  
are available, please note :do not set the baudrate great than 38400bps.  

Note ：if you change com port or baudrate after connecting to the central unit , you should 
reconnect again. 

6.2.12 Setup ->language  

Setting of software language, there are two options: English and Chinese. New change will 
take effect on next startup of the program.  
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6.2.13 Help ->About DS380 Tool  

Some message about DS380 Tool, include company name, telephone number. 

 

6.3 APPENDIX： 

Wiring diagrams of the serial communication cable. 
 
Brown -----2 
White-------3 
Black-------5 
Blue---------5 

 

 

 

 

 

TO HC3900 Central unit         to 9 pin serial port of PC 
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7 ERROR CODE 

Error 
code 

Error Cause Elimination 

E 01 

Fallen below the 
radius range or 
angle range 
exceeded. 

Fallen below the minimum 
radius or exceeding the 
maximum angle specified in the 
respective load chart due to 
luffing up the boom too far 

Luff down the boom to a 
radius Or angle preset in the 
load chart 

E 02 

Max. radius 
exceeded or 
Fallen below the 
angle range 

The maximum radius was 
exceeded or fallen below the 
Minimum angle specified in the 
respective load chart due to 
luffing down the boom too far 

Luff up the boom  

to a radius or an angle reset 
in the load chart 

E 03 

Boom position is 
out of the 
permissible 
working area 

Exceeded the permissible 
working area with load 

Move boom back 

to the permissible working 
area 

E 04 
Operating mode 
not  

existing 

Incorrect setting of OM or enter 
into impermissible working area 

Correctly set Operating mode 
according to actual operation 
or move back to the 
permissible working area 

E 05 
Prohibited length 
range 

a) boom has been extended too 
far or not enough ,e.g. if operation 
is only admitted up to a certain 
boom length or for load charts of 
jibs with the boom having to be 
extended to a certain length 

b) the length sensor adjustment 
changed i.e. length sensor cable 
slid off the length sensor drum 

c) Clutch between length sensor 
pot and drive is defective 

d) cable between the central unit 
and the length sensor defective or 
slack 

e) length potentiometer defective 

a) telescope boom to correct 
length, given in the load 
capacity chart 
b) Retract the boom. Check the 
pre-stress of the cable reel(the 
rope has to be under traction 
open the length sensor and 
carefully turn the length pot 
counterclockwise by use of a 
screwdriver to make the 
displayed value the same with 
the actual length of the boom 
c) completely replace the clutch 
with the drive wheel and adjust 
length sensor pot as described 
at b 
d) check cable as well as 
connectors and exchange, if 
necessary 

e) replace length potentiometer 
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Error 
code Error Cause Elimination 

E 11 

Fallen below limit 
for the measuring 
channel “length 

Telescopic boom” 

 

a) cable between length sensor and 
central unit defective not connected 
or water in the connectors 

b) length sensor pot defective 

c) electronic board in the measuring 
channel defective 

a) check cable and 
connectors as well and 
replace, if necessary 

b) replace length sensor pot 

c) replace main board  

E 12 

Fallen below Lower 
limit value For the 
measuring  

channel “ pressure  

Transducer rod 
side” 

a) cable leading from the central unit 
to the pressure transducers defective 
or water in the connectors. 

b) pressure transducer defective 

c) electronic board in the measuring 
channel defective 

a) Check cable and 
connectors as well and 
replace, if necessary. 

b) replace pressure 
transducer 

c) replace main board 

E 13 

Fallen below lower 
limit value For the 
measuring channel 
“pressure 
Transducer piston 
side” 

a) cable between central unit to the 
pressure transducer defective or 
water in the connectors 

b) pressure transducer defective 

c) electronic board in the measuring 
channel defective 

a) check cable &connectors 
as well and replace, if 
necessary 

b) replace pressure 
transducer 

c) replace main board 

E 15 

Fallen below lower 
limit value for the 
measuring channel 
“angle  

Main boom” 

a) cable between central unit to the 
length/angle sensor defective, loose 
or water in the connectors 

b) angle sensor defective 

c) electronic board in the measuring 
channel defective 

a) check cable &connectors 
as well and replace if 
necessary 

b) replace angle sensor  

c) replace main board 

E 19 
Reference voltage 

defective 

a) reference voltage is less than 3.6V 

b) A/D converter defective 

a) check supply voltage 

b) replace  main board 

E 21 

Exceeded the 
upper limit value for 
measuring channel 
“length telescopic 
boom” 

a) cable between length/angle sensor 
to central unit defective or water in the 
connectors 

b) length pot defective 

c) electronic board in the measuring 
channel defective 

a) check cable & connectors 
and replace if necessary 

b) replace length 
potentiometer 

c) replace main board 
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Error 
code Error Cause Elimination 

E 22 

Exceeded the 
upper limit value for 
measuring channel 
“pressure 
transducer rod 
side” 

a) cable between pressure transducer 
to central unit defective or water in the 
connector 

b) pressure transducer defective 

c) electronic board in the measuring 
channel defective 

a) check cable and 
connector, and replace if 
necessary 

b) replace pressure 
transducer 

c) replace main board 

E 23 

Exceeded the 
upper limit value for 
measuring channel 
“pressure 
transducer piston 
side” 

a) cable between pressure transducer 
to central unit defective or water in the 
connector 

b) pressure transducer defective 

c) electronic board in the measuring 
channel defective 

a) check cable and 
connector, and replace if 
necessary 

b) replace pressure 
transducer 

c) replace main board 

E 25 

Exceeded upper 
limit value for 
measuring channel 
“angle main boom” 

a) cable between central unit to 
length/angle sensor defective or 
water in the water 

b) angle sensor defective 

c) electronic board in the measuring 
channel defective 

a) check cable &connectors 
replace if need 

b) replace angle sensor 

c) replace main board 

E 29 
Reference voltage 
defective 

a) reference voltage is higher than 
4.4V 

b) A/D converter defective 

a) check voltage supply 

b) replace main board 

E 31 
Cannot store the 
overload memory’s 
counter 

a) chip trouble 

b) chip drop off 

c) in-correct setting of the chip’s 
jumper 

d) overload record over than 1000 
times 

a) set the overload chips’ 
jumper (JIP1,JP2) to 512K 

b) replace chips and test the 
overload record 

c) replace main board 

E 38 
Wrong system 
program in the SL1 

The system program in the SLI does 
not match the programming in the 
data EPROM 

Replace system program 
EPROM 
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Error 
code Error Cause Elimination 

E39 
Voltage of the analog 
input over than it’s 
measurement range 

The voltage supply in the 
analog channel or A2B 
switch is over 5V 

a) check the ground connection of 
the sensors 

b) check the test-point’s  

c) check 8V voltage 

d) check if the analog signal is 
connected with high voltage 

e) check if the A2B switch connect 
with high voltage 

f) If it cause the circuit board 
distortion by tightening the screw 
replace main board 

E 41 

Error in the internal 
write/ Read memory 
(RAM) of the computer 
module C167 

 
a) replace computer module C167 

b) replace main board 

E 42 
Error in the external 
write/read 
memory(RAM)defective 

 

a) replace write/read memory 
(CMOS) 

b) replace SLI main board 

E 46 Cannot write data into 
overload chips 

a) chips drop off 

b) incorrect setting of the 
chip’s jumper 

c) chips defective 

d) malfunction of the 
working voltage 

a) high voltage in the analog 
channel 

b) check the setting of the jumper 

c) replace chips and do the overload 
test 

d) replace main board 

E 47 
Load chart CRC 
calibration is not correct 

The data in the load chart 
was lost or been changed 

a) check the load chart chip 

b) check the load chart chip’s +5V 
supply 

c) replace the load chart data 

d) replace load chart chips 

E48 Defective of load chart 
chips 

a) chips drop off 

b) chips defective 

a) replace the load chart data chips 

b) check if high voltage pass the 
analog channel 

c) check the digital channel’s 5V 
supply 

d) replace main board 
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Error 
code Error Cause Elimination 

E 49 

Faulty data 
during 
on-line 
operation 

Upon loading, no valid data are to be 
found on the RMA in the memory 
extension in on-Line-programming 

a) replace memo. extension 

b) replace on-line interface 

c) replace SLI main board 

E 51 
Error in the 
FLASH 

Error in the FLASH data Replace data FLASH 

E 80 

Short circuit 
between 
length cable 
and A2B 
switch 

a) cable to A2B switch defective 

b) A2B switch defective 

c) electronics in the main board 
defective 

a) check cable 

b) check the A2B switch 

c) replace main board 

E 91 

No data 
transmission 
from console 
to central 
unit 

a) no 24V power supply to the 
console 

b) circuit of the electronics from 
console to central unit broken or 
touch the ground 

c) electronic board of the 
send/receiver defective 

a) check 24V power supply in 

b) check the connection between 
console electronics and central unit, 
if find defective, replace it 

c) replace console electronics or 
related SLI main board 

E 92 

Error in the 
data 
transmission 
from console 
to central 
unit 

a)circuit from console electronics to 
central unit not connected properly 

b)electronic board of the 
send/receiver defective 

a)check the connection between 
console electronics & central unit 

b) replace console electronics or 
corresponding SLI main board 

E 93 

Error in the 
data 
transmission 
from central 
unit to the 
console 

a)improper connection between 
central unit to console 

b)electronic board of the 
send/receiver defective 

a) check circuit to the console 

b) replace console electronics or 
corresponding SLI main board 

E 94 

No data 
transmission 
from central 
unit to the 
console 

a) circuit from central unit to the 
console is broken or touch the 
ground 

b) 5V power supply in the central unit 
is defective 

c) 5V power supply is too low 

d) data send/receive defective 

a) check connection of the console 
b) check the connection of the power 
supply 
c) replace electronics 
d) replace electronics of the console 
or central unit 
e) check the FLASH 
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e) data FLASH defective 

f )  computer module defective 

g)coupler defective 

f )  replace main board of the central 
unit 
g)replace computer module 
h)replace the coupler of main board 
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